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Gravity: How fast do objects fall? 
Teacher Advanced Version 

(Grade Level: 8 – 12) 
 
*** Experiment with Audacity and Excel to be sure you know how to do what’s needed for 
the lab*** 
 
 Kinematics is the study of how things move – their position, velocity, and acceleration. 
Acceleration is always due to some force acting on an object, in a car this force is provided by 
the engine or the brake pedal. Today, we will focus on a particular force that we experience 
constantly – the force of gravity. In this lab we'll use a computer program to mark the times at 
which washers on a string hit the ground, and use these measurements to calculate the velocity of 
the string and to see whether it accelerates. We'll also look at whether the mass of an object (the 
amount of “stuff” in it) affects how fast it falls.  
 
California Science Content Standards: 

• 1. Motion and Forces: Newton's laws predict the motion of most objects. 
• 1e. Students know the relationship between the universal law of gravitation and the effect 

of gravity on an object at the surface of Earth. 
• 2. Conservation of Energy and Momentum: The laws of conservation of energy and 

momentum provide a way to predict and describe the movement of objects. 
• 2c. Students know how to solve problems involving conservation of energy in simple 

systems, such as falling objects. 
 
Prerequisites:  

Arithmetic (including square roots), calculator skills, plotting data, basic algebra on the 
level of Pre-algebra or Algebra 1 courses in most schools (manipulating equations, linear 
relationship between two variables) 
 
Complete List of Materials: 
• 1 laptop with microphone (either built-in or separately attached), Excel and the program 

Audacity installed (see instructions on downloading and installing Audacity below) 
• 1-2 calculators 
• 1 meter stick (with metric markings) 
• 1 large paperback book or workbook 
• 1 piece of string with a metal weight tied at the end and 5 metal washers tied along it at 30cm 

separation (Part 1 only) 
• 3 pieces of aluminum foil (about 6in long, but the precise size does not matter) 
• 1-2 thick textbooks (Part 2 only) 
• 2 large marbles (Part 2 only) 
• 1 ping-pong ball (Part 2 only) 
• 1 cardboard tube (eg: from a paper towel roll) (Part 2 only) 
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Instructions for downloading and installing Audacity on your computer: 
1. Go to the website: http://audacity.sourceforge.net/ 
2. Click on “Download Audacity 1.2.6a” 
3. Depending on your type of computer you have, download the appropriate version (Mac 

users: if you aren’t sure what kind of processor you have, click on the blue Apple icon in 
the top left corner of your screen, then click on “About this Mac”. The processor line will 
tell you whether you have Intel or PowerPC) 

4. Once you click on the appropriate link, follow the “Installation Instructions” on the 
Audacity website. Click on the Audacity icon to launch the application. 

5. Make sure the microphone is working by clicking the record button and tapping the table 
next to the computer a few times. To get rid of the recording, go to EditàUndo. 

6. Make sure the time under the “Selection Start:” at the bottom of the screen is set to 
hh:mm:ss + milliseconds 

 
Preparation and Lab Notes: 

• Download and install Audacity according to the instructions below. Make sure the 
microphone is working properly. 

• Open up Excel and Audacity on each laptop that the students will be using. 
 
Key Concepts: 

l Velocity = change in position ÷ change in time 
l Acceleration = change in velocity ÷ change in time 
l Gravity accelerates all objects at the same rate (regardless of mass). This means that as an 

object begins to fall, it moves faster and faster (its velocity increases). Heavy and light 
falling objects will reach the ground at the same time 

l An object moving with a constant acceleration (a) for a time (t) covers a distance (d) 
given by: d = ½ at2 

l When we want to test that two measured physical variables are related by a particular 
equation, we can often arrange the hypothesized equation to give a linear relationship 
between two variables that can be calculated from the experiment (“linearizing the data”), 
then check to see whether the data do in fact fall on a line. Unknown physical constants 
(eg: acceleration of gravity) can be extracted from the slope of the line. 

 
Introductory mini-lecture: 
 Kinematics is the study of how things move – their position, velocity, and acceleration. 
Position tells us where an object is (eg: that car is on the corner of 1st and 2nd street). Velocity 
indicates how fast (speed) and in what direction the object is moving (eg: the car is driving south 
at 30 miles per hour).  When we report the velocity in “miles per hour”, what we are really 
saying is that the car will change its position by 30 miles in a time of 1 hour, 60 miles in 2 hours, 
and so forth. The velocity (or speed or rate) is calculated as “rate equals distance divided by 
time”. You may also have heard of the equivalent equation “distance equals rate times time”.  
 Just like velocity was defined as a rate of change in position, we can define a new 
quantity, the acceleration, which is the rate of change in velocity.  Large acceleration means the 
object is suddenly slowing down or suddenly speeding up. Acceleration is defined as the change 
in velocity divided by the time interval it took for this change to occur (eg: if a car goes from 0 to 
60mph in 3 seconds, the acceleration is 20 miles per hour per second).  
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Suppose we know some object starts at rest and then moves with a constant acceleration 
(a) for a time (t). That is, it starts out stationary and then gradually increases its velocity, moving 
faster and faster up to time t. How far will the object have traveled in that time? Well, we know it 
goes from having 0 velocity to having a velocity of a*t (remember acceleration is how fast the 
velocity changes per unit time). So the objects average velocity during this time period is vavg= ½ 
a*t. To get the distance it moves in time t, we just have to use distance = rate times time, to see 
that d = ½ at2. This is the formula for distance traveled by an object at constant acceleration.  
 Acceleration is always caused by some force, in this lab we'll focus on a force that we 
feel constantly – the gravity of the Earth. We will use a computer program to mark the times at 
which washers on a string hit the ground, and use these measurements to see that the times and 
distances fallen are consistent with the formula found above. These measurements will enable us 
to calculate the magnitude of gravitational acceleration. In the second part of the lab, we'll make 
another measurement of this acceleration and we will see whether the mass of an object (the 
amount of matter in it) affects how fast it falls.  

 
Part 1 – Distance versus Time for a Falling Object 

 
In this first part you will measure the acceleration of gravity directly by calculating how the 
velocity of a falling object changes with time. You will use the microphone on your computer to 
accurately measure the time it takes for washers to fall different distances. 
 
Procedure: 
1. Your lab kit should include a long string with washers tied to it. One person should stand up 

and dangle the string so that it hangs down straight and so that the metal weight on the 
bottom is just touching the ground. The other person should use a meter stick to measure 
the distance from the ground to each washer. Fill in the distance in the data table below.  
Also fill in the square root of the distance in the second column. 
 
**TEACHER NOTE** 
Make sure all distance measurements are done in cm! 
 
**TEACHER NOTE** 
If students are confused about what part of the washer to measure to, encourage them to think 
about the relevant distance for how far the washers fall before they make a sound (either the 
bottom of the washer or its center is reasonable, and should not make much difference in the 
results) 
 

2. Place a large paperback book or workbook under a piece of aluminum foil on the floor. 
Place the computer on a chair near the aluminum foil.   

3. Make sure Audacity is up on your computer. Hit the Record button (button with the red 
circle) and tap the aluminum foil with your finger a few times, to make sure you can see 
the sound being graphed on the screen. You may need to adjust the microphone volume up 
to increase the signal or down to decrease the noise. The volume can get adjusted using the 
slider next to the microphone icon: 

 
Go to Edit->Undo to get rid of the test recording.  
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4. Two students should work together to carry out the experiment: 

Person 1: dangle the string over the piece of aluminum foil so that the weight at the end 
is just touching the foil. Stand on a chair if necessary.  

Person 2: hit the record button on the computer and tell Person 1 you have done so. 
Person 1: After you get the signal from Person 2, let go of the string. The washers should 

fall one by one onto the foil, with each one making a sound when it strikes. 
Person 2: Stop the recording.  
 
**TEACHER NOTE** 
For ease of visualizing the data at the end, it is better if the times are not too big (ie: the 
students don’t wait too long after starting the recording before dropping the string). If there is 
a delay (bigger than 10sec or so), encourage the students to subtract a constant value (eg: 10 
sec) from all the time measurements, effectively shifting what we call 0 time. 
 
 

5. Look at the Audacity display and make sure that you can see 5 peaks on the graph 
corresponding to each of the washers hitting the ground. If the signal looks too messy to 
make out the peaks, you may need to redo the experiment. It should look something like the 
below image. 

 
6. To find the time at which each washer hit the ground, position the cursor over the peak in 

Audacity (using the mouse or arrow keys). To see the peaks more closely, use the mouse 
to highlight all the peaks and then zoom in by going to View->Zoom to Selection to look 
similar to the below image.  

 
Look at the bottom of the Audacity window. There should be a line that says “Selection 
Start:”, make sure the time there is set to hh:mm:ss + milliseconds. These numbers give the 
time corresponding to the cursor. In your data table, fill in the time at which each washer 
hit the ground.     
 
**TEACHER NOTE** 
Encourage students to think about which part of the peaks is appropriate for the 
measurements. Generally, you want the very start of each peak since that is when the washer 
first touches the ground to make the sound. 
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7. Repeat steps 4 to 6 once more, recording the times in the column for trial 2. 
 
Data Table: 

Distance (cm) 

€ 

distance  Time (sec), Trial 1 Time (sec), Trial 2 
about 30 cm about 5.5   
about 60 cm about 7.7   
about 90 cm about 9.5   
about 120 cm about 11   
about 150 cm about 12.2    

 
Q1.  What does a time of 0 correspond to in this experiment? 
 
Time 0 is when you start the recording. All other times are measured as the time after 
pressing the record button. 
 
You will now use this data to calculate an approximation to the acceleration of gravity. 
The formula for an object falling under constant acceleration is: 

€ 

d =  1
2
at 2  

(Where d is the distance an object falls in time t, if it has acceleration a) 
8. Rearrange the formula to solve for time (t) in terms of the other variables (get t by itself 

on one side of the equation). The result should look like some coefficient (that does not 
involve distance) times some function of distance 

 

__)(_______)/2(__ dat ×=  
          coefficient        function of d 
 

9.  What two variables (involving experimentally measured quantities) should we plot so 
that we would expect a linear relationship?  
Remember, a linear relationship looks like: 

€ 

y = (slope) × (x)  
Our y variable will be: t 
Our x variable will be: square root of d 
We expect the slope of the line to be: 2 / a  
(Hint: this will involve the acceleration variable) 
Even though acceleration is a variable, remember that on Earth the acceleration of Gravity 
never changes so in this case the variable a is constant.   
You will use Excel to see if the data really does look linear and to find the slope of the line 
that best approximates your data. 
 
 

10. Excel should be open on your computer. At the top of the first column, enter the values of 
your x variable (you have already calculated them in the Data Table above). Next to that, in 
the second column, enter the values of your y variable from Trial 1. In column 3, enter 
the y variable values from Trial 2. Use the mouse to highlight all the numbers that you 
entered. 
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11. In the menu at the top of the screen, go to Insert à  Chart. Under chart type, select “XY 
(Scatter)”.  Click Finish. Excel will show a graph with two series of data points. Each series 
of points corresponds to data from one trial. 

 
Q2.  Is the data what you expected, with the points from each trial falling on a straight line?  
Data should fall on a line for each trial 
 
Q3.  Are the two lines approximately parallel? Why would you expect this to be the case? 

(Hint: parallel lines have the same slope) 
Yes, the lines should be approximately parallel. 

 
Q4.  Why are the lines from the two trials offset from one another? What does the y-intercept 

correspond to here? (Hint: the y intercept is the time when distance fallen is 0) 
The y intercept is the time at which you let go of the string (when it starts to fall). The lines 
will be offset because there were different delays between hitting the record button and 
dropping the string.  

 
12. Click on the first series of data points to select it. In the top menu, go to Chart à  Add 

Trendline. Make sure “Linear” is selected. Then click on the Options tab at the top and click 
on the box that says “Display equation on chart”. Click OK. Excel has now drawn the line 
of best fit for your points and has shown you the equation of that line. Repeat for the other 
series of data points. 

 
 
 
                
 
 
 
 
 
13. Fill in the equation for the line of best fit (remember, your y variable is time t and your x 

variable is square root of the distance, 

€ 

d ): 
Trial 1: 

€ 

y = _________ x + ____________         (

€ 

t = ___slope__ d + ____________ ) 
Trial 2: 

€ 

y = _________ x + ____________  
 

Q5.  What is the slope found by Excel?  
Slope for Trial 1 = should be about 0.04 

  Slope for Trial 2 =  
14. Go back to your expression for the slope in terms of the acceleration a. Set this equal to 

the slope you found and solve for the acceleration of gravity! 
Slope as a function of a (copied from step 9):  
Rearranging gives: a = 2/(slope)2 
Measured acceleration of gravity (trial 1) = should be about 1000 cm/s2 
Measured acceleration of gravity (trial 2) = _______________  

€ 

2 /a
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15. Find the average acceleration from your two trials: 
Average acceleration = (acceleration[trial 1] + acceleration[trial 2])÷ 2 =  about 1000 cm/s2 

(values between 900 and 1400 are common) 
Follow-up questions: 
Q6.  The real gravitational acceleration is 980 cm/s2. What is the percent error in your 
measurement?  
 
 % error =  (measured average acceleration - 980 ) ÷ 980 ×  100 =  _______________ 
Errors of 20-40% are common 
 
Q7.  Do the time intervals between the washers hitting the ground increase, decrease, or stay the 

same as more washers hit? What does this mean about the velocity of the string? 
 
As more washers hit, the time intervals should decrease. This means the string is moving faster 
as faster. It is accelerating and thus its velocity is becoming more negative. 
 
Q8.  If you changed the spacing of your washers to all be 20cm apart and then repeated the 

experiment, would you expect the slope of the line to change? Explain why not or in which 
direction? 

 
No, the slope only depends on the gravitational acceleration, which is constant. 
 
Q9.  If you changed the spacing of your washers to 20cm apart, would you expect the time 

intervals between the different washers hitting the ground to change as compared to a 
30cm separation? Explain why not or in which direction? 

 
If the washers are spaced closer together, you would expect the time intervals to decrease 
because they will still be moving at the same velocities but will have to travel shorter distances.  
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Part 2 – Gravity and Mass 
 

 
 

In this part, you will measure the acceleration of gravity in another way, and also look at the 
effect of the mass of the falling object. 
 
Procedure: 
1. Use 2 to 3 books to angle your paper towel tube to make a ramp near the edge of the 

table. Place a marble at the very edge of the table, right next to an open end of the tube. 
If you have trouble with the marble rolling away from the edge, use a piece of aluminum foil 
to make a slightly rough surface for it to lie on. 

2. Roll another marble down the paper towel tube so that it knocks your first marble off 
the table. Place a piece of aluminum foil on the floor approximately where the first 
marble fell. Reset your ramp and marble at the edge of the table as before. 

 
**TEACHER NOTE** 

It is important for the bottom marble to be as close as possible to the table edge and also to be 
right up against the edge of the tube. Generally, results will be more accurate with a steeper 
ramp. These precautions are to minimize the time between when the microphone hears the 
marbles hitting and when the bottom marble actually leaves the table. 
 
3. Just like in Part 1, one person should be in charge of recording, and one person should 

perform the experiment. Make sure the microphone of your computer is near the marble on 
the edge of the table. 

4. Person 1: press the record button on Audacity 
Person 2: Roll the 2nd marble down the paper towel tube so that it knocks the first 

marble off the table 
Person 1: stop the recording 

5. Look at the graph of sound that you recorded and find the peaks where the microphone 
heard the two marbles hitting and where the first marble hit the foil on the floor. Zoom 
in and/or play back the recording if you aren't sure which peaks are the correct ones. 
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**TEACHER NOTE** 
There will generally be two peaks at the beginning (first the marbles hitting then the top marble 
hitting the table) and two peaks at the end (each marble hitting the ground). The first peak is the 
one to use in both cases. 
 
6. Find the time interval between when the marble was struck and when it hit the floor. 

Fill this in as Trial 1 in the data table below. Repeat the experiment one more time for 
Trial 2.  

For a typical height table (71 cm), the time intervals should be about 0.4 sec and the calculated 
acceleration should be about 900 cm/s2 

 
Trial 1:  
 Time when marble was struck: _____________ 
 Time when marble hit the ground: __________ 
  
Trial 2: 
 Time when marble was struck: _____________ 
 Time when marble hit the ground: __________ 
  

7.   Measure the height from the floor to the table. 
Height from which marble fell: ______________cm 
 

8. Use the formula for the distance (d) fallen in time (t) by an object with acceleration (a): 

€ 

d = 1
2
at2  

Solve for acceleration in terms of the other variables: 
     a = 2d/t2 
 
9. Plugging in the height of the table for d and the measured time intervals for t, calculate the 

acceleration of gravity from each trial of your experiment, and enter the values in the 
Data Table. 

 
10.  Now repeat the experiment, but this time use a ping-pong ball at the edge of the table.  

Fill in the data table as before. Note: you may have to adjust the aluminum foil to make 
sure the ping-pong ball strikes it when it falls! 

 
Trial 1:  
 Time when ping-pong ball was struck: ____________ 
 Time when ping-pong ball hit the ground: __________  
Trial 2: 
 Time when ping-pong ball was struck: ____________ 
 Time when ping-pong ball hit the ground: __________ 
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Data Table: (approximate values are for a 71cm high table; your results may vary) 
 marble ping-pong ball 

Time interval (Trial 1) ~0.4 s ~0.4 s 
Time interval (Trial 2) ~0.4 s ~0.4 s 
Acceleration (Trial 1) ~900 cm/s2 ~900 cm/s2 
Acceleration (Trial 2) ~900 cm/s2 ~900 cm/s2 

 
Follow-up questions: 
Q10. Was there a significant difference in the time of falling for the ping-pong ball versus the 

marble? 
 
 The times of falling should be approximately the same for the marble and the ping-pong 
ball. That is, the difference between those times should not be much greater than the differences 
between trials. 
 
Q11. Does the acceleration of gravity depend on the mass of the object? 
 
No, it does not. 
 
Q12. Which traveled a greater distance overall in the time it took to reach the ground, the 

marble or the ping-pong ball? What does that mean about the horizontal velocity of each 
ball as it rolled off the table? 

 
 The ping-pong ball will travel faster. That means it has a greater horizontal velocity to 
start with. Note that while gravity gives the ball and the marble the same vertical velocities, their 
velocity in the horizontal direction is entirely a different thing. 
 
Q13. What would happen if you used fewer books to make a less steep ramp?  
 This would mean that the top marble hits the bottom one less strongly, so the horizontal 
velocity would decrease. However the time traveled is related only to the height and the 
acceleration of gravity, so that would not change. Smaller horizontal velocity but same time 
means that the ball would travel less far horizontally. 
 

Horizontal velocity coming off the table would:   increase / decrease / stay the same 
Time to hit the floor would:          increase / decrease / stay the same 
Horizontal distance the ball travels would:       increase / decrease / stay the same 
(Try the experiment, if you're not sure!) 

 
Q14. If gravity gives all objects the same acceleration, then why does a sheet of paper fall slower 

than a pebble? Why does a sky-diver with a parachute fall slower than one without? (both 
reasons are the same) 

 
 Near the surface of the planet, gravity is not the only force that affects how fast things 
fall. There is also air resistance from the atmosphere which slows down a falling object. The 
bigger the surface of the object viewed from below, the more air it has to push out of its way, and 
the more air resistance it experiences. A parachute feels a lot more air resistance than just the 
skydiver alone. 



Created by LABScI at Stanford 11 

 Note: the analogous resistance to moving water out of the way is the reason that things 
fall slower in a pool than they do in the air. 
 
Q15. Challenge question: Can you explain the answers to questions 3 & 4 using conservation of 

energy? 
(Hint: the kinetic energy of a moving object is 

€ 

KE = 12mv
2  and the potential energy of an 

object at height h is 

€ 

PE = mgh  (where m is the mass, h is the height, v is the velocity, and g 
is the acceleration of gravity). The total energy of the system is conserved, which means 
the energy of the 1st marble as it rolls to the bottom of the ramp must equal the total energy 
of the two balls as they roll off the table. ) 

 
(3) The kinetic energy of the 1st marble as it rolls of the ramp is the same in both cases, So about 
the same amount of energy will be imparted to both the ping-pong ball and the marble at the 
edge of the table.  
Since  

€ 

KE = 12mv
2  and the mass of the ping-pong ball is lower than the marble, that means the 

initial velocity of the ping-pong ball must be higher. So it flies off with a greater horizontal 
velocity and covers a greater horizontal distance in the same amount of time. 
 
(4) Decreasing the height of the ramp will decrease the total energy of the marble as it rolls 
down the ramp. This means that the ball at the edge of the table will fly off at a slower horizontal 
velocity and will travel less far. However, since it still has 0 vertical velocity when it leaves the 
table, and since horizontal and vertical motion are separate from each other, the time to reach 
the floor is still given by 

€ 

2d /g  , which does not depend on how hard the bottom ball is hit. 
Thus, the time to fall will remain the same. 
 
 


